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Preparing for the Course 

The suite of exercises provided in this document represent Part 1 (i.e. Exercises 1&2) of the self-directed 
training course. By the end of these exercises you should be able to build and run your own simple model 
using ST-Sim. When done you can optionally continue on to Part 2 of the course, which covers additional 
advanced features. 

1. Download and install SyncroSim for Windows 

ST-Sim is an open-source plug-in “package” that runs within the SyncroSim software. As a result you will 
need to download and install the SyncroSim software on your local computer. For this introductory 
course we will be using version 2.2.27 of SyncroSim for Windows, which is the version that was 
available at the time this course was originally developed in January 2021. 

Using your web browser, navigate to: https://syncrosim.com/download-id/syncrosim-for-windows-version-
2-2-27/ to download and install SyncroSim version 2.2.27. 

Note: if you have a more recent version of SyncroSim already installed you will need to uninstall it 
first in order to install and run SyncroSim version 2.2.27. Alternatively you can proceed with the 
course by using the latest version of SyncroSim, in which case some of the course instructions may be 
slightly out-of-date. After you have completed the course you should always upgrade to the latest 
version. 

2. Complete the online homework (optional) 

Before you begin working through the course, you will benefit by reviewing the online Overview of 
SyncroSim and completing the 30-minute Quickstart Tutorial for SyncroSim. 
 

3. Download and install course files 

1. Download the zip file https://apexrms.com/download/stsim-course-files-part-1/ 
 

2. Create a new folder for the course files on your computer. We recommend you create a folder 
called “Course” under the existing folder Documents\SyncroSim. 
 

3. Unzip the contents of the downloaded file to this new folder (i.e., right-click on the zip file, select 
Extract All, set Documents\SyncroSim\Course as the destination for extracted files, then click 
on Extract). 
 

4. A series of subfolders should now appear in your Course folder as shown below. Note that only 
files for Exercises 1 and 2 are included in Part 1; files for Part 2 of the course (i.e., Exercises 3 to 
8) are available from https://apexrms.com/training.  

 

https://apexrms.com/training/
https://syncrosim.com/download-id/syncrosim-for-windows-version-2-2-27/
https://syncrosim.com/download-id/syncrosim-for-windows-version-2-2-27/
https://syncrosim.com/download
http://docs.syncrosim.com/getting_started/overview.html
http://docs.syncrosim.com/getting_started/overview.html
http://docs.syncrosim.com/getting_started/quickstart.html
https://apexrms.com/download/stsim-course-files-part-1/
https://apexrms.com/training
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4. Follow the online course material and exercises 

In this self-directed course you will listen to a recording of a live 2-day course (delivered in Australia in 
January 2021), pausing the recording periodically to do exercises at your own pace. 
 
• The video playlist for the original live course has been divided into the following 11 segments: 

Course Overview Exercise 5: Spatial variability 
Introduction Exercise 6: Attributes 
Exercise 1: Getting started Exercise 7: Stocks and flows 
Exercise 2: Spatial model Exercise 8: Command line & R 
Exercise 3: Landscape stratification Other Advanced Features 
Exercise 4: Temporal variability  

• A video recording of the entire course can be viewed as a YouTube playlist at: 
https://youtube.com/playlist?list=PL57N-QiM8Rikg1ih5ieogJDv9Wa9TMA67 

• To avoid a blurry presentation, make sure your YouTube Quality is set to 1080p (under the 
Settings icon at the bottom right of the YouTube window) 

• Specific instructions for each of the exercises can be found in the remainder of this document. 

 

5. Ask questions and provide feedback 

We encourage you to ask questions and provide feedback both during and after the course through the 
ST-Sim Self-Directed Course Forum; you can also purchase additional hourly support at any time. 
 

6. Continue with Part 2 of the course 

To continue on with Part 2 (Exercises 3-8) of this course, see the instructions at 
https://apexrms.com/training. 

https://youtube.com/playlist?list=PL57N-QiM8Rikg1ih5ieogJDv9Wa9TMA67
https://syncrosim.com/forums/
https://apexrms.com/support/
https://apexrms.com/training
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Exercise 1: Getting started with ST-Sim 

Objectives 

• Build and run a simple, non-spatial state-and-transition simulation model 
• View graphs of results 
• Compare alternative future scenarios 

 
In this exercise, you will create a simple state-and-transition simulation model that forecasts the fate of a 
forested landscape 40 years into the future, based on the example first presented in Daniel et al. (2016). 
Conceptually, each spatial cell in this landscape today has been classified into one of three possible 
states (D = Deciduous, M = Mixed, C = Coniferous). The age of each cell today has also been recorded. 
Based on a pathway diagram specifying the transition probabilities between states (panel b below), your 
model will then stochastically forecast the future composition of this landscape in response to transitions 
due to Succession (S), Fire (F) and Harvest (H). 
 
Note that the model you will create in this exercise will be non-spatial – that is, the model will be initialized 
using landscape totals for the area in each state and age, rather than cell-by-cell (i.e., mapped) values; 
future exercises will show you how to make your model fully spatial. 
 

183B  
 
 
  

https://doi.org/10.1111/2041-210X.12597
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Below are the numeric details of the pathway diagram we will use for this exercise. Note that Succession 
and Fire transitions are expressed as annual transition probabilities (with Succession transitions also 
conditional on age), while Harvest uses a target for the total area to transition each year. 
 

185B  
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Task 1 – Create a new ST-Sim library 

We will start by downloading the stsim package required for this course and create a new, empty ST-Sim 
Library. A Library is simply a file (with extension.ssim) for storing all of your model inputs and outputs. 

1. Open SyncroSim. Under the File menu, select Packages. This will open the Packages window 
displaying a list of all the installed packages. If you have not installed any packages prior to this 
exercise, this list will be blank.  
 

14B  
 

2. If you are running the version of SyncroSim recommended for the course (i.e. version 2.2.27 – 
you can check this under the Help | About SyncroSim menu):  

Click on Install from File in the upper right corner of the Packages window. Navigate to 
your Course folder, select the file called “stsim-3-2-28.ssimpkg”, and click Open to install 
the package. Repeat for the file called “stsimsf-3-2-17.ssimpkg”. These are the versions 
of each package used in the original live course. 

3. If you are running the latest version of SyncroSim (i.e. greater than version 2.2.27):  

Click on the Install button in the lower left corner of the Packages window to go to the 
SyncroSim Package Server. Select the packages called “stsim” and “stsmsf” and click 
Ok. These are the latest versions of each package. 

4. You should see both packages now listed in the Packages window. Close the Packages 
window.  

 

 
 



Getting started with ST-Sim Page 4 
 

16B  
 

5. Navigate to the File menu, and select New Library. In the upper pane of the New Library 
window, click on the stsim package to select it. Click on the Empty Library template. In the File 
name field at the bottom of the New Library window, rename the file to “Exercise 1.ssim”. Click 
on the Browse button and navigate to the Course \ Exercise 1 folder. Click OK.  
 

188B  
 

6. Your new Library will open in the SyncroSim Library Explorer. When creating a new Library, one 
empty scenario called New Scenario will be automatically created for you. Scenarios provide a 
clear and organized template for entering and storing values for your model’s required inputs. 
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190B  
 
Now that you have created a new empty Library, you are ready to begin setting up various basic 
definitions for it. These definitions are generally terms that you specify in order to customize the model to 
your specific landscape. Note that definitions will be shared by all scenarios in your Library. 

7. To set model definitions, right-click on Definitions and select Properties. Navigate to the 
Terminology tab where you will define the terminology to be used for your particular model. Set 
Amount Units to Hectares, and set State Label X to Forest Type.  
 

193B  
 

8. Switch to the Strata tab. In ST-Sim, a landscape can be stratified spatially according to up to 
three possible dimensions (more on this in later exercises). For this simple model, we will keep 
the entire landscape in a single stratum – to do this we will define a single Primary Stratum and 
call it Entire Forest. 
 

195B  
 

9. Switch to the States tab to define the state classes for your model. Each unique State Class is 
identified according to its Class and Subclass. Earlier we told ST-Sim (in the Library’s 
Terminology settings) to refer to the class as a Forest Type, which we will define now. Create 
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the following three forest types: Deciduous, Mixed and Coniferous. 
 

196B  
 

10. Still on the States tab, click on Subclass on the left sidebar. As we will not be defining any 
subclasses for this model, we add a single Subclass called All. 
 

197B  
 

11. Switch to the Transitions tab. For our model, there are three transitions: Succession, Fire and 
Harvest. Click on Transition Type on the left sidebar and enter these three transitions into the 
table. 
 

198B  
 

12. Close the Definitions window and save your model by clicking the Save All  icon on the main 
toolbar.  
 

Task 2 – Configure a scenario 

Now that you have completed your model definitions, you can create your first simulation scenario. This 
scenario will hold the input values for your model. As you develop scenarios in SyncroSim, all of the data 
associated with each scenario are stored automatically in your SyncroSim Library. 
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1. Your new Library opened with a single empty scenario (called New Scenario) in it. Right-click on 
this New Scenario and select Properties. Rename the scenario “No Timber Harvest”. You may 
choose to enter your name as the Owner of the scenario, and enter a brief Description, e.g., 
“Simple model of a forested landscape with no timber harvest”. 
 

2. Switch to the Run Control tab. Here you will define the timeframe and number of Monte Carlo 
iterations you wish to run. Set the Start timestep to 0 and the End timestep to 40 (40 years), 
and Total iterations to 100.This model is non-spatial, so leave the checkbox unchecked. 

202B  
 

3. Switch to the Transition Pathways tab.  Here you will define your model’s pathway diagram, 
including probabilities and age limits for the various transitions that can occur.  

 
Remember that this is a three-state model, where the State Class of each cell can be one of three 
possible forest types (Deciduous, Mixed or Coniferous).The pathway diagram for the model then 
specifies three possible transition types (Succession, Fire and Harvest) that can move a cell from 
one State Class to another over time (as defined in Step 9 of Task 1 above). A table summarizing 
the transitions you will enter into the model is shown at the end of Step 8.  

4. To add a State Class (box) to your pathway diagram, right-click anywhere on the white space of 
the Transition Pathways window, and select Add State Class from the context menu.  In the 
Add State Class window, open the Forest Type drop-down list, select Deciduous and click OK 
to add the first State Class to your diagram.  Repeat this step, but select Mixed as the Forest 
Type. Repeat one more time and select Coniferous. 
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205B  
 

206B  
 

5. Double-click (or right-click) on the Deciduous State Class box to open it. There are two transitions 
that can occur for this forest type: Succession and Fire.  In the Probabilistic Transitions pane, 
add a row where you tell ST-Sim that the Deciduous Class will transition to the Mixed To Class 
according to a Transition Type of Succession with an annual Probability of 0.1 (see image 
below). To specify that this transition should only occur once a cell is 10 years old or more, right-
click on the table and toggle the Age Min option to make this column visible. Set the value for 
Age Min to 10 years. 
 

6. In the second row of the table, set the Deciduous State Class to transition back to itself (i.e., both 
Class and To Class should be Deciduous) via Fire with an annual probability of 0.05 (i.e., Fire 
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occurring on the landscape about every 20 years). 
 

207B  
 

When you close the window, you will see the two transitions you just defined for the Deciduous 
State Class on the pathway diagram. 
 

7. Next, open the Mixed State Class box(right-click or double-click). Recall that for a cell to be 
classified as Mixed it must be at least 10 years old. To set this property for the Mixed State Class, 
right-click on the States pane to add the Min Age field, and enter 10. In the Probabilistic 
Transitions pane, set the Mixed class to transition to Coniferous via Succession, with a 
Probability of 0.1 and a Min Age of 20. In the second row of the table, set the Mixed State Class 
to transition to Deciduous via Fire with a Probability of 0.08 (or 8% annually).  Close the window. 
 

26B  
 

8. Open the Coniferous State Class. In the States pane, set the Min Age for the Coniferous forest 
type to be 20 years. In the Probabilistic Transitions pane, set Coniferous to transition to 
Deciduous via Fire with a Probability of 0.15.   
 



Getting started with ST-Sim Page 10 
 

208B  
 

You now have a basic pathway diagram in ST-Sim that represents the model presented at the 
beginning of this exercise (without Harvest). Your pathway diagram should look similar to the 
image below. 
 

29B  
 
To see a complete list of all the transitions you just entered, on the Transition Pathways tab for 
your scenario, click on Transitions near the bottom of the window to bring up a worksheet 
containing the transition pathways table. To see all transitions, you will need to add the optional 
To Class and Min Age fields from the context menu. 
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209B

 
 

9. The next step in configuring your scenario is defining the size and resolution of your forested 
landscape. To do this, switch to the Initial Conditions tab and click on Non Spatial on the left 
sidebar. Set Total (hectares) to 1,000 and Number of simulation cells to 1,000. This means 
that the total size of the hypothetical landscape in this model is 1,000 hectares and each 
simulation cell, or parcel of land, is one hectare in size.  
 

211B  
 

10. Because you are creating a non-spatial model (as opposed to working with map inputs), you must 
specify the proportion of the landscape that is in each State Class (i.e., forest type) at the start of 
the simulation (later on, we will touch upon how to specify initial conditions using raster maps). 
Still on the Initial Conditions tab, right-click on the Distribution table and add the Age Min and 
Age Max optional fields. For each of the entries below, the Primary Stratum will be Entire 
Forest. 

a) 32BFor the Deciduous State Class, set Age Max to 10 years, and set Relative Amount to 
40% of the landscape.  

b) 33BFor the Mixed State Class, set the age range to be 10-20 years (Age Min = 10, Age Max 
= 20), and set Relative Amount to 40% of the landscape. 

c) 34BFor the Coniferous State Class, set the age range to be 60-100 years, and set Relative 
Amount to20% of the landscape. 
 

Note that the Relative Amount values do not have to add to 100; they could be expressed as 
hectares or proportions of the landscape and the model will re-normalize at the start of the 
simulation. Close the Scenario window and Save your work. 
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212B

 
 

Task 3 – Run the scenario and view results 

1. The next step is to run your scenario. To do this, either right-click on the scenario in the Library 
Explorer pane and select Run from the context menu, or click on the Run Scenario icon in on 
the toolbar at the top of your screen. The Run Monitor will track the progress of your run and 
notify you of any issues encountered. When the run is done, close the Run Monitor. 
 

2. You are now ready to analyse your results. In the Library Explorer, expand the node for the No 
Timber Harvest scenario you just ran. You will see a Results folder containing a Results 
Scenario. This Results Scenario contains your model outputs and will have a red checkmark 
beside it indicating that it has been added to the Results Viewer. The Results Viewer is a pane 
situated below the Library Explorer with three tabs for viewing and exporting results. On the 
Charts tab, click on the New icon       to open a New Chart window. Name the new chart “States 
and Transitions” and click OK to close the New Chart window.  
 

215B  
 



Getting started with ST-Sim Page 13 
 

3. The left sidebar of your States and Transitions charting window lists the variables that you can 
chart over the course of the simulation. You can create charts showing the average amount of 
area in each of the three forest types, and the average amount of area undergoing each of the 
three types of transitions. 

a) 217BTo generate charts of transitions over time, expand the Transitions node to see the 
available variables and select Area (Hectares). Under Disaggregate By, select 
Transition Type/Group. This will create a separate chart for each of your three transition 
types (Succession, Fire, and Harvest). 

b) 218BTo generate charts of forest types over time, expand the State Classes node to see the 
available variables, and select Area (Hectares). Under Disaggregate By, select Forest 
Type. This will create a separate chart for each of your three forest types (Deciduous, 
Mixed, and Coniferous).   

c) 219BTo display model uncertainty on your charts, modify the error bar type by clicking on No 
Ranges near the top of the window and selecting Min/Max from the Error Bar Type drop-
down menu. 

d) 220BClick Apply (upper right corner of the charting window) to display your charts. 
 

221B  
 
Your charts should look something like this: 
 

 



Getting started with ST-Sim Page 14 
 

223B

 
 

4. Because your simulation ran many Monte Carlo iterations, you can get a sense of the variability 
across all iterations. To do this, change the Error Bar Type to Percentile (see image below). Set 
the range as 2.5 to 97.5. This represents a 95% Monte Carlo confidence interval.  Click Apply. 
 

224B  
 

The variability is represented by the shaded area around each line. 
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226B

 
The charts show the average area for Coniferous and Mixed forest types decreasing over time, 
while the area of Deciduous forest type increases over time. Both Fire and Succession are 
occurring on the landscape, but timber Harvest is not. Close your charting window. 
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Task 4 – Create a second scenario and compare results 

The final task for this exercise will be to create a scenario in which some timber harvest occurs and 
compare this scenario to the previous one where no timber harvest occurs on the landscape.  
 

1. In the Library Explorer, right-click on the No Timber Harvest scenario and select Copy. Right-
click on Definitions and select Paste. Double-click on the copied scenario to open it. On the 
Summary tab, rename the copy to “Harvest 20 Hectares per Year”, and edit the Description to 
indicate that some harvest will be occurring. 
 

229B  
 

2. To add Harvest dynamics to your model, switch to the Transition Pathways tab and click on 
Transitions at the bottom of the window. In the table, enter a new row (i.e., transition pathway) in 
which a cell in the Coniferous State Class transitions to Deciduous via Harvest when the age of 
the cell is greater than 30 years. Unlike Fire and Succession transitions which occur 
stochastically in the model to reflect real-life variability, a Harvest transition can be specified as a 
target or absolute amount of area within the landscape. Here we have specified that Harvest only 
occurs in Coniferous stands (i.e., cells) that are at least 30 years old. Because you will specify the 
level of Harvest as a target rather than a probability, set the Probability of Harvest to 1. 
 
231B
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3. To define a Harvest transition target, click on the Transition Targets tab for your scenario. Set 
the Target Area for the Harvest transition to 20 hectares per year. Close the Scenario window 
and Save your work. 
 
233B

 
 

4. Run the new scenario (either right-click and select Run, or click on the Run Scenario icon on the 
toolbar).  
 

5. When the run is complete, the results will show up immediately in the States and Transitions 
chart that you created based on the No Timber Harvest scenario.   

Your charts should look something like this: 
236B
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What is the effect on the composition of the landscape of adding timber harvest? Why does the 
amount of timber harvest change over the course of the simulation? 

 
 
 

Bonus Question: Try running a scenario in which you assume that fire suppression is able to 
double the fire return interval for the landscape (Hint: probability = 1 / return interval). What effect 
does the model say this management action would have on the future composition of the 
landscape? And how would harvest be affected by this change? 
 
 
 
 

6. When you are done, Save your work (File | Save All) and then Close your Library (File | Close 
All).  
 

7. Finally, to check your work, select the File | Open Library menu, navigate to the Exercise 1 
folder and open the SyncroSim library file called “Exercise 1 Solution.ssim”. This contains all the 
of library settings as they should appear once you have completed the exercise. At the end of this 
manual you will also find answers to the written questions throughout each exercise. 
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Exercise 2: Running a model spatially 

Objectives 

• Learn about working with templates and folders 
• Set up definitions for spatial simulations 
• Load input maps and run spatial simulations 
• Create size distributions to simulate transition events 

 
In this exercise you will learn how to use and edit templates that come with SyncroSim. SyncroSim 
Templates are Libraries that contain pre-configured scenarios with model inputs. You will begin with a 
Template, called “Non-spatial Example” that contains the exact model inputs you used in Exercise 1, and 
edit this non-spatial Template into one that can be used in a spatial simulation.  
 

Task 1 – Create a new library using templates 

1. From the File menu, select New Library. Left-click to select the stsim package and choose the 
Non-Spatial Example template. Set the folder path to the file destination Course\Exercise 2.  
Click OK.  
 

43B  
 

2. When the Library opens, you’ll see the two scenarios and the charts that were created in Exercise 
1.  Right-click on the Non-Spatial Example Library and rename it “Exercise 2”.  
 

3. For this exercise, you will only be working with the harvest scenario, so you can delete the No 
Timber Harvest scenario from your Exercise 2 Library.  To do this, right-click on the scenario 
name and select Delete from the context menu.  Click Yes when prompted for confirmation. 
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Task 2 – Set up definitions for spatial simulations 

In this exercise we will be specifying our initial conditions using raster maps. In this task we will look at 
each of these maps and then set up our Library definitions to be able to correctly interpret each of them. 
 
All raster files in this exercise are provided in GeoTIFF format. The first raster file (called initial-
stratum.tif) defines the spatial bounds of the entire study area for our simulation. As displayed below, 
this raster defines a landscape that is almost square, is 1,000 hectares in size, and has 1,000 cells. Every 
cell in the raster is also assigned a value of 1. We will eventually use this raster to define our Primary 
Stratum in ST-Sim (recall that we previously defined a single Primary Stratum called Entire Forest to 
represent the entire study area). 

243B  
 

A second input raster file (called initial-age.tif) of exactly the same size and shape as the previous raster, 
specifies the initial forest type of each cell in our landscape (see below). In this raster a value of 1 
represents Deciduous, 2 represents Mixed, and 3 represents Coniferous. Note that the proportion of cells 
in each forest type in this raster exactly matches the landscape totals provided in the previous non-spatial 
exercise (i.e., 40% Deciduous, 40% Mixed, and 20% Coniferous).  
 

245B  
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The last input raster file (called initial-age.tif) specifies the age of each cell (again with the same size and 
number of cells as the previous raster). This age raster also matches the landscape totals in the previous 
non-spatial exercise (i.e., 40% age 0-9, 40% age 10-19, and 20% age 60-100). 
 

247B  
 

In order to use these maps to specify our initial conditions spatially in ST-Sim, we first need to modify a 
few of our previous model definitions. The next few steps will be telling ST-Sim how to interpret the values 
in each of these rasters. 
 

1. Double-click on Definitions for your Exercise 2 Library.  In the Definitions window, navigate to 
the Strata tab and click on Primary Stratum on the left sidebar. Right-click on the table and add 
an ID column. Set the ID of Entire Forest to 1. This tells ST-Sim that a value of 1 on the Primary 
Stratum raster represents the cells that are within the study area. 
 

47B  
 

2. Switch to the States tab and click on State Class on the left sidebar.  Right-click on the table and 
add an ID and Color column.  For Coniferous, set the ID to 3 and the color to green (double-click 
to open the color palate). For Mixed, set the ID to 2 and the color to burgundy. For Deciduous, set 
the ID to 1 and the color to yellow. Now when you load your State Class map, every cell that has 
a value of 3, for example, will get initialized to the Coniferous forest type.  
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49B  
 

3. Switch to the Transitions tab and click on Transition Type on the left sidebar. While there are 
no input maps of transitions, we will eventually be generating output rasters for each transition 
type. Here we will be associating a value and color to display for each transition. Right-click on 
the table and add an ID and Color column.  For Fire, set the ID to 2 and the color to red.  For 
Harvest, set the ID to 3 and the color to purple.  For Succession, set the ID to 1 and the color to 
yellow.  Close the Definitions window and Save your work. 
 

51B  
 

Task 3 – Create a new spatial scenario 

You will now import the raster data so you can run the model spatially.  The simplest way to do this is to 
edit a copy of the existing non-spatial harvest scenario. 
 

1. To start we will create a new folder within our Library in which to store the existing non-spatial 
scenario for safe-keeping. Right-click on Definitions, select New | Folder and name it “Non-
spatial Simulation Scenarios”. Click OK. 
 

2. Rename the existing harvest scenario to “Harvest 20 Hectares per Year - Non-spatial” (right-click, 
Rename, add “Non-spatial” to the end, then click OK). To move this scenario into the folder you 
just created, click and hold the left mouse button and drag the scenario into the folder. 
 

3. Next create another new folder (right-click on Definitions as you did in Step 1) and call it “Spatial 
Simulation Scenarios”.  
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4. Expand the Non-spatial Simulation Scenarios folder to show the previous non-spatial scenario 
inside it.  Right-click on the scenario name and select Copy from the context menu.  Right-click 
on the Spatial Simulation Scenarios folder and select Paste to put a copy of the non-spatial 
scenario into the folder.  Before making any modifications to this scenario, Rename the copy to 
“Harvest 20 Hectares per Year – Spatial” (i.e., change “Non-spatial” to “Spatial”). 
 

56B  
 

5. We will now edit this new scenario to make it spatial. Right-click on the scenario Harvest 20 
Hectares per Year – Spatial and select Properties. On the Summary tab, modify the 
Description to indicate that the scenario is spatial and that there will be some harvest. 
 

58B  
 

6. Switch to the Run Control tab and select to run the model spatially by checking the Run model 
spatially box. 
 

60B  
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7. When we ran this model non-spatially in the previous exercise, we specified the initial distribution 
of each of the three forest types (and ages) across the landscape (using the Initial Conditions 
tab). Take a moment to review these values (we will modify them in the next Task). 
 

8. Switch to the Output Options tab.  For the non-spatial run in the last exercise, we did not 
explicitly define what model outputs we wanted over time.  For our spatial run, we want to see a 
Tabular output for State classes every timestep and Transitions every timestep.  Note that the 
Include ages boxes get checked automatically. 
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9. Switch to the Spatial node on the left sidebar. In the checklist, select outputs for State classes 
every timestep, Ages every timestep, and Transitions every timestep. Close the Scenario window 
and Save your work. 
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Task 4 – Define initial conditions using maps 

The last change we need to make to our new spatial scenario is to the way the initial conditions are 
specified. 
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1. Open the scenario Harvest 20 Hectares per Year – Spatial again, and click on the Initial 

Conditions tab.  In the last exercise, you used the Non Spatial node on the left sidebar to 
initialize your landscape to be 1,000 hectares in size, with 1,000 simulation cells, and a specific 
distribution of forest types.  As you will be using maps to initialize your landscape in this exercise, 
you may delete the existing information in this tab.  First, right-click on any one of the cells in the 
Distribution table and select Delete All. Next, click the Clear All button above the table to 
remove the information on landscape and cell size.   
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2. On the left sidebar of the Initial Conditions tab, now click on the Spatial node; this is where you 
can navigate to the different raster files that you need to load. Note that you do not need to have 
raster files for every field in this table (only the Primary Stratum and State Class rasters are 
required).  For this exercise, you will load raster files for Primary Stratum, State Class and Age. 
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3. The next step is to load these files into your model.  On the Spatial node of the Initial 
Conditions tab, click on the folder icon beside Primary stratum in the table.  Navigate to your 
Course\Exercise 02 \Files folder and select the initial-stratum.tif file. Click Open to load the 
file.  Repeat this process for the State Class and Age raster files. 
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4. Click in any cell in the bottom pane of the window to automatically populate the fields there 
according to the information in the raster files just loaded.  
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5. Close the Scenario window and Save your work. 

Task 5 – Run the model and view results 

1. Before running your current spatial model, first run the Harvest 20 Hectares per Year – Non-
spatial scenario.  The results generated will automatically be added to your States and 
Transitions chart.  
 

2. Right-click on the scenario called Harvest 20 Hectares per Year – Spatial and select Run.  
When done, close the Run Monitor. The results for this scenario run will be shown immediately 
on the States and Transitions chart, along with the results for the first scenario.   
 
Your charts should look something like this: 
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Note that both scenarios look almost identical to each other. This makes sense as both scenarios 
begin with the same initial conditions at timestep zero. 
 
What do you notice about the Harvest Transition Area graph? Is the 20 hectare per year harvest 
target sustainable over 40 years? 
 
Looking at the Coniferous, Deciduous, and Mixed State Class graphs, what trends do you notice 
between these three forest types?  
 
Close the States and Transitions chart window. Right-click on the non-spatial results again and 
select Remove from Results. Note that this action does not delete these results; it simply 
removes them from the output charts/maps. 
 

3. To view maps generated from your spatial simulation, click on the Maps tab and create a new 
map (by clicking on the       icon) and call it “States and Ages”. Click OK. 
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4. In the left sidebar of the States and Ages map window, expand the State Classes node and 
click on the Iteration checkbox. Expand the Ages node and click on the Iteration checkbox. To 
see these values change over time, in the Timestep field at the top of the window enter 0,20,40 
where 0 represents our initial conditions, 20 is half-way through the simulation, and 40 is the end 
of the simulation. Click Apply. 
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5. The maps that appear represent the results from the spatial scenario that used input maps to 
initialize the landscape. The first row shows maps of State Class for each simulation cell and the 
bottom row shows maps of forest Age. The legend on the left sidebar shows the different colors 
used by the model to represent the state classes and ages in the maps. 
 
Your maps should look something like this: 
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How would you describe the State Class and Age distribution patterns on your landscape in 
Timestep 0? How do these patterns differ from Timestep 20 and Timestep 40? 
 
These maps are presently showing just the first Monte Carlo realization for the simulation. You 
can scroll through the Monte Carlos using the up and down arrows beside the Iteration field at 
the top of the map. 
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6. You may choose to change the colors used in the maps by editing the Legend.  To do this, 
double-click on one of the colors in the Ages node to open the Edit Legend window. Double-click 
on the color you wish to change, e.g., 20 (years), and select a color from the color palate.  Click 
OK to close the palate and close the Edit Legend window.  Back on the map, click Apply to 
update the Legend to use the new color. 
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7. Close the States and Ages map. The next map that we want to create is one that will show the 
transitions that occur over time. On the Maps tab, create a new map called Transitions.  In the 
left sidebar of the map window, expand the Transitions node, then the Iteration node, and select 
all three transitions (Fire, Harvest, and Succession). Set the Timestepsto1, 20 and 40. Click 
Apply. 
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Your map will show cells that transition according to Fire in the top row, Harvest in the second 
row, and Succession in the third row for Timesteps 1, 20 and 40. Like the States and Ages 
maps, you can scroll through different iterations in the Transitions maps and edit the Legend. 
 
How would you describe the patterns for Fire, Harvest, and Succession transitions across the 
landscape? 
 

Task 6 – Define transition size distributions 

The random pattern for Fire transition produced by the last simulation is unrealistic, as a fire event 
typically starts with an ignition point and then spreads to neighboring cells. In this task you will learn how 
to specify spatial patterns for how transitions occur within a simulation. Keep the Transitions map 
window open and click Arrange All on the SyncroSim toolbar (      ). 
 

1. Start by making a copy of the scenario Harvest 20 Hectares per Year – Spatial and pasting it 
into the same folder (Spatial Simulation Scenarios).  Open (double-click) the scenario and 
rename it “Harvest 20 Hectares per Year – Spatial with size distribution”. 
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2. Switch to the Advanced tab. Expand the Transitions – Spatial node, expand the Transition 
Size node, and click on Transition Size Distribution. 
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3. In the table on the right, define a frequency distribution for the size of fire events on the 
landscape. In the Transition Type/Group field, select Fire.  Enter 1 for Maximum Area 
(Hectares) and 40 for Relative Amount.  This means that 40% of fire events on the landscape 
will be between 0 and 1 hectare in size. In the next three rows of the table, enter values so 
that30% of fires on the landscape will be from 1 to 10 hectares in size, 20% of fires will be from 
10 to 100 hectares in size, and 10% of fires will be from 10 to 1,000 hectares in size.  
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4. Close the Scenario window. Save your work and Run the scenario.  When the run is done, close 
the Run Monitor. 
 

5. As before, the results of the latest run immediately populate the map that is presently open. This 
time, we want to focus on the Fire transition, so start by turning off the Harvest and Succession 
transitions. Set the Timesteps to 1-40. Click Apply.  By comparing the two scenarios in this map, 
you can see that the scenario with a defined fire size distribution shows fire events rather than 
individual cells transitioning.  
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6. Close the Transitions map and Save your work.  Click on the Charts tab and open the States 
and Transitions chart.  Click on Arrange All. 
 
What differences do you notice between the two spatial runs? 
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7. Close the States and Transitions chart window. Before opening the States and Ages map one 
last time, remove the results for the first spatial scenario (Harvest 20 Hectares per Year – 
Spatial).  
 

8. Open the States and Ages map and click Arrange All.  Show only the first 20 timesteps of the 
simulation by entering0-20 in the Timesteps field and click Apply.  
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9. Slide the scroll bar at the bottom of the window back and forth to view all timesteps from 0-20. 
 
What changes do you notice across the landscape? 
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10. Save your work and close the Library (File | Close All). 
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Answers to Questions 

Exercise 1: Task 4 
 
What is the effect on the composition of the landscape of adding timber harvest? Why does the 
amount of timber harvest change over the course of the simulation? 
Adding harvest reduces the amount of conifer forest on the landscape in the early years (i.e. up to about 
year 15), with a corresponding increase in the amount of deciduous forest for this same period. By year 
15, however, the composition of the landscape is very similar for both scenarios. This is because the 
target level of 20 ha/yr of harvest, which occurs only in older conifer forests, leads to a transition from 
conifer to deciduous. However by year 7 there is no older conifer left on the landscape (due to the 
previous years’ harvest) so the harvest drops to zero, and thus the two scenarios act similarly from this 
point onwards. 
 
Bonus Question: Try running a scenario in which you assume that fire suppression is able to 
double the fire return interval for the landscape (Hint: probability = 1 / return interval). What effect 
does the model say this management action would have on the future composition of the 
landscape? How would harvest be affected by this change? 
We can represent doubling the fire return interval in the model by halving the fire transition probabilities. If 
we do this we see that there is far more conifer and mixed forest left on the landscape, with a 
corresponding reduction in the amount of deciduous forest. The amount of harvest is thus able to 
increase due to the increase in available older conifer forest that is no longer disturbed by fire. 
 
 
Exercise 2: Task 5 
 
What do you notice about the Harvest Transition Area graph? Is the 20 hectare per year harvest 
target sustainable over 40 years? 
The level of harvest drops from its target of 20 ha/yr to zero around Timestep 7. It then rises again to a 
level of less than 5 ha/yr for the remainder of the simulation. This suggests that a harvest of 20 ha/yr is 
not sustainable for this landscape. 
 
Looking at the Coniferous, Deciduous, and Mixed State Class graphs, what trends do you notice 
between these three forest types? 
The stability of the state class area in the last 15 Timesteps of the simulation suggest that the landscape 
reaches an equilibrium by the end of the 40 Timestep simulation corresponding to the transition 
probabilities for Succession and Fire, combined with an equilibrium Harvest level of approximately 2 
ha/yr. 
 
How would you describe the State Class and Age distribution patterns on your landscape in 
Timestep 0? How do these patterns differ from Timestep 20 and Timestep 40? 
In Timestep 0 the State Class and Age raster maps both show strong spatial-autocorrelation (i.e. 
clumpiness) in their distribution, as one would expect in the boreal forest. However by Timestep 20 and 
40 the spatial autocorrelation disappears (i.e. the raster maps show a speckled distribution). 
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How would you describe the patterns for Fire, Harvest, and Succession transitions across the 
landscape?  
The maps of projected transitions also show no spatial autocorrelation (i.e. they are speckled), which for 
Fire and Harvest does not seem appropriate. 
 
 
Exercise 2: Task 6 
 
What differences do you notice between the two spatial runs? 
The original spatial simulation (with no size distribution specified for Fire) shows no spatial autocorrelation 
– i.e. the cells burned appear to have been selected randomly. In contrast, the simulation with a size 
distribution shows strong spatial autocorrelation in the distribution of burned cells across the landscape. 
 
What changes do you notice across the landscape?  
The landscape becomes increasingly Deciduous and younger as the simulation progresses. 
 


	Preparing for the Course
	1. Download and install SyncroSim for Windows
	2. Complete the online homework (optional)
	3. Download and install course files
	4. Follow the online course material and exercises
	5. Ask questions and provide feedback
	6. Continue with Part 2 of the course

	Exercise 1: Getting started with ST-Sim
	Objectives
	Task 1 – Create a new ST-Sim library
	Task 2 – Configure a scenario
	Task 3 – Run the scenario and view results
	Task 4 – Create a second scenario and compare results

	Exercise 2: Running a model spatially
	Objectives
	Task 1 – Create a new library using templates
	Task 2 – Set up definitions for spatial simulations
	Task 3 – Create a new spatial scenario
	Task 4 – Define initial conditions using maps
	Task 5 – Run the model and view results
	Task 6 – Define transition size distributions

	Answers to Questions

